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Hi	@Jim1701	Welcome	to	the	HP	support	community.I	understand	you're	experiencing	an	issue	with	your	HP	device,	and	I	apologize	for	any	inconvenience	this	may	have	caused.	I'm	here	to	help	you	today.	To	install	the	latest	drivers	for	your	HP	Photosmart	e-All-in-One	Printer	(D110a)	on	a	Mac	running	macOS	15.1	(Sequoia),	follow	these	steps:1.
Download	HP	Drivers	from	the	HP	WebsiteOpen	your	web	browser	and	go	to	the	official	HP	Support	page.In	the	search	bar,	type	your	printer	model:	HP	Photosmart	D110a.Select	your	printer	from	the	search	results	and	go	to	the	Downloads	section.Choose	macOS	as	the	operating	system,	and	select	macOS	15	or	the	most	recent	version.Download	the
latest	driver	package	available	for	your	Mac.2.	Install	the	DriversOnce	the	driver	package	is	downloaded,	open	the	file	(usually	a	.dmg	file)	to	mount	the	disk	image.Follow	the	on-screen	instructions	to	install	the	drivers.	You	might	need	to	enter	your	Mac	admin	password	during	installation.Once	the	installation	is	complete,	restart	your	Mac	if
prompted.3.	Add	the	PrinterAfter	installation,	go	to	Apple	Menu	>	System	Preferences	>	Printers	&	Scanners.Click	the	+	sign	to	add	a	new	printer.Your	HP	Photosmart	D110a	should	appear	in	the	list	of	available	printers.	Select	it,	and	click	Add.4.	Set	as	Default	Printer	(Optional)	To	set	it	as	the	default	printer,	right-click	on	it	in	Printers	&	Scanners,
and	choose	Set	as	Default	Printer.I	hope	this	helps!	Keep	me	posted.Please	click	Accepted	Solution	if	you	feel	my	post	solved	your	issue,	it	will	help	others	find	the	solution.-RegardsRaj-HP	Support	Raj2111	I	am	an	HP	Employee	Hello	@Raeview,Welcome	to	the	HP	Support	Community!Here	is	the	link:	on	Software	&	Drivers	then	select	the	operating
system.	All	drivers	will	now	be	made	available	to	you.I	hope	this	helps	you.Kind	RegardsAndr-1611If	my	post	resolved	your	problem	please	mark	this	post	as	an	"Accepted	Solution".Or	click	on	the	YES	button	to	reply	that	the	response	was	helpful	and/or	to	say	Thank	You.	I'm	not	an	employee	of	HP,	I'm	as	volunteer	here.Inquiries	via	private	messages
(PM)	cannot	be	answered.	View	solution	in	original	post	I	went	ahead	and	downloaded	the	330	drivers	here:	then	extracted,	and	updated	the	drivers	through	the	Device	Manager.	Now	running	330	no	problem,	so	my	fears	regarding	missing	out	on	a	"critical"	update	as	reported	by	both	Dell	and	Lenovo	are	now	alleviated.But....HP....please	just	add
and	update	the	drivers	on	the	product	page	and	be	sure	Windows	Update	also	updates	this	product's	Realtek	WLAN	drivers	automatically.BTW....if	you	try	to	clean	install	Win	11	24H2	to	skip	the	HP	bloatware,	you	will	get	hung	up	and	stopped	if	you	don't	have	the	Realtek	WLAN	drivers	to	install.	No	internet	connection,	no	finishing	the	install.	When
I	first	got	the	laptop	I	didn't	bother	to	confirm	WLAN	manufacturer,	just	assumed	if	I	needed	drivers	I	could	download	from	HP.	When	I	kept	getting	errors	that	the	drivers	weren't	found,	I	had	to	use	a	cloud	recovery	USB	to	reinstall	and	that's	how	I	discovered	the	laptop	had	a	Reaktek	WLAN	and	not	the	Intel	as	listed	on	the	drivers	page.
Then....reformat,	clean	reinstall	24H2,	then	install	the	drivers	extracted	from	the	Microsoft	Update	Catalog	.cab	file.Thanks	to	Paul_Tikkanen	for	helping.	View	solution	in	original	post	Your	account	also	allows	you	to	connect	with	HP	support	faster,	access	a	personal	dashboard	to	manage	all	of	your	devices	in	one	place,	view	warranty	information,
case	status	and	more.	Thanks	for	reaching	out	about	your	query	regarding	Touchpad	driver	Windows	11	Pro	x64	for	HP	Pavilion	Power	Laptop	15-cb0xx!We're	thrilled	to	have	the	opportunity	to	assist	you	and	provide	a	solution.Since	your	touchpad	is	not	working	after	installing	Windows	11	Pro	x64	on	your	HP	Pavilion	Power	-	15-cb059tx,	lets	go
through	some	steps	to	fix	the	issue.Check	if	the	Touchpad	is	EnabledPress	Windows	+	I	to	open	Settings.Navigate	to	Bluetooth	&	devices	>	Touchpad.Ensure	the	Touchpad	toggle	is	turned	ON.Install	the	Latest	Touchpad	DriverGo	to	HP	Support.Enter	your	laptop	model:	HP	Pavilion	Power	-	15-cb059txor	theserial	numberof	your	productExpand
Driver	-	Keyboard,	Mouse,	and	Input	Devices.Download	and	install	the	Synaptics	or	ELAN	Touchpad	Driver	for	Windows	11.Restart	your	laptop.Update	or	Roll	Back	the	Touchpad	Driver	via	Device	ManagerRight-click	the	Start	Menu	and	select	Device	Manager.Expand	Mice	and	other	pointing	devices.Right-click	Synaptics/ELAN/Precision	Touchpad
and	select	Update	driver.Choose	Search	automatically	for	drivers.If	that	doesnt	work,	select	Uninstall	device	and	restart	your	laptopWindows	should	reinstall	the	driver	automatically.Install	Windows	Precision	Drivers	(Alternative	Solution)If	the	above	steps	dont	work,	you	can	try	installing	Microsoft	Precision	Touchpad	drivers	manually:Open	Device
Manager	>	Mice	and	other	pointing	devices.Right-click	Synaptics/ELAN	Touchpad	and	choose	Update	driver.Select	Browse	my	computer	for	drivers	>	Let	me	pick	from	a	list	of	available	drivers	on	my	computer.Select	HID-compliant	touchpad	or	Microsoft	Precision	Touchpad	and	install	it.Restart	your	laptop.Perform	a	Windows	UpdateGo	to	Settings
>	Windows	Update.Click	Check	for	updates	and	install	any	available	updates.If	none	of	these	steps	resolve	the	issue,	please	let	me	know.	Click	here	for	more	troubleshooting	steps.	Take	care,	and	have	an	amazing	day!Did	we	resolve	the	issue?	If	yes,	Please	consider	marking	this	post	as	"Accepted	Solution"	and	click	"Yes"	to	give	us	a	helpful	vote	-
your	feedback	keeps	us	going!	Regards,	Hi	@Genpat1704,	Welcome	to	HP	Support	Community.	Thank	you	for	posting	your	query,	I	will	be	glad	to	help	you.	To	reinstall	your	HP	LaserJet	P1102	printer,	follow	these	steps	based	on	your	operating	system.	For	Windows:Connect	the	Printer:	Ensure	the	printer	is	connected	to	your	computer	via	USB	and
turned	on.Download	the	Driver:	Go	to	the	HP	Support	website.	Search	for	"HP	LaserJet	P1102"	and	download	the	latest	driver	for	your	version	of	Windows.Install	the	Driver:	Open	the	downloaded	file	and	follow	the	on-screen	instructions	to	install	the	printer	driver.Add	the	Printer:	Open	Settings	>	Devices	>	Printers	&	scanners.	Click	on	Add	a
printer	or	scanner.	Select	your	HP	LaserJet	P1102	from	the	list	and	click	Add	device.Test	Printing:	After	installation,	try	printing	a	test	page	to	ensure	everything	is	working	correctly.For	macOS:Connect	the	Printer:	Connect	your	printer	to	your	Mac	using	a	USB	cable	and	turn	it	on.Download	the	Driver:	Visit	the	HP	Support	website.	Search	for	"HP
LaserJet	P1102"	and	download	the	driver	compatible	with	your	macOS	version.Install	the	Driver:	Open	the	downloaded	file	and	follow	the	installation	instructions.Add	the	Printer:	Open	System	Preferences	>	Printers	&	Scanners.	Click	the	+	button	to	add	a	printer.	Select	your	HP	LaserJet	P1102	from	the	list	and	click	Add.Test	Printing:	Print	a	test
page	to	confirm	that	the	installation	was	successful.Additional	Tips:	Ensure	that	your	computer	is	connected	to	the	internet	when	downloading	drivers.	If	the	printer	doesnt	appear	during	the	installation,	try	restarting	your	computer	and	the	printer,	then	attempt	the	installation	again.	I	hope	this	helps.	Take	care	and	have	a	good	day.	Please	click
Accepted	Solution	if	you	feel	my	post	solved	your	issue,	it	will	help	others	find	the	solution.	Click	the	Kudos/Thumbs	Up"	on	the	bottom	right	to	say	Thanks	for	helping!	Alden4HP	Support	Raj_05HP	Support	Community	Moderator	@KissifurWelcome	to	the	HP	Community	--	We	are	a	Peer-to-Peer	Forum	for	people	who	use	HP	Technology.Sure	-	seems
like	a	reasonable	assumption.I	don't	know	whether	the	software	works	in	the	way	you	expect.In	truth,	I	no	longer	use	HPSA	--	I	currently	have	all	business	class	systems	--	I	use	HPIA	(HP	Image	Assistant)	when	I	wish	to	automate	the	driver	update	check	/	installation	process.I've	used	the	HPSA	in	the	past.My	understanding	of	HPSA	--	based	on
previous	experience:HPSA	will	update	currently	installed	Drivers	and	Software	as	compared	to	the	list	of	the	available	updates	(at	HP)	when	it	is	clear	to	the	HPSA	application	which	version	is	relevant.HPSA	cannot	always	discern	how	to	find	or	select	the	Operating	System	running	on	the	computer	as	compared	to	the	(HP)	location	where	HPSA	wants
to	source	the	"updates".	This	is	particularly	the	case	when	the	Operating	System	running	on	the	computer	is	not	supported	by	the	drivers	/	software	in	Software	and	Drivers.	This	confusion	can	also	be	the	result	when	there	being	more	than	one	choice	of	OS	version.	HPSA	might	choose	wrong	or	perhaps	not	choose	a	Source	at	all	(and	hang	/	spin	/
balk	/	complain).HPSA	might	(attempt	to)	download	and	install	the	wrong	BIOS	-	this	action	might	result	in	the	BIOS	not	loading	(as	would	be	appropriate),	the	BIOS	loading	and	bricking	the	computer,	or	anything	in	between.If	you	wish	to	do	so,Join	the	many	who	decide	--	for	whatever	reason	--	to	manually	check	and	install	drivers	and	updates.You
can	also	(instead)	switch	OFF	the	"Software	Update	Settings"	(automatic	updates)	in	HP	Support	Assistant	>	SettingsDoing	helps	you	reclaim	control	over	how	and	when	updates	are	installed.Example	-	HP	Support	Assistant	-	SettingsHPSA_App_Settings_Auto-Updates_6Manual	Updates	-	Check	/	Compare	/.	InstallOpen	Category	Software	and	drivers
for	HP	15.6	inch	Laptop	PC	15-e2000	(2J4W0AV)Select	Operating	System	=	WindowsSelect	Version	=	Windows	11	--	OR	--	If	offered,	Select	the	build	level	/	versionClick	to	Open	All	DriversSelect	Open	AllSort	by	Release	Date	>	Descending	order	(arrow	pointing	down)The	drivers	listed	are	relevant	to	your	computer's	series	of	systems.True	-	Not	all
drivers	in	the	Software	and	Drivers	list	are	for	YOUR	computer.Check	the	drivers	in	the	list	compared	to	the	installed	drivers	using	the	Device	Manager,Control	Panel	>	icon	view	>	Device	ManagerTab	View	>	Check	Show	hidden	devicesOpen	Driver	(for	example	Biometric	Devices)Right-Click	on	Driver	>	Select	/	open	PropertiesTab	DriverCompare
Driver	version	to	the	driver	listed	in	system's	support	page	Category	Software	and	DriversExample	-	Device	Manager	-	Check	Driver	(Fingerprint)	in	Software	and	Drivers	compared	to	installed	versionDevice_Manager_Category_Software-and-Drivers_Check_1References	/	ResourcesAdvanced	usersSystem	Information	or	other	methods	to	help
determine	what	is	installed	as	compared	to	where	and	what	you	want	to	update.Control	Panel	>	icon	view	>	Device	ManagerTab	View	>	Check	Show	hidden	devicesWindows	10	--	Control	Panel	>	icon	view	>	Administrative	Tools	>	Double-Click	System	InformationWindows	11	--	Control	Panel	>	icon	view	>	Windows	Tools	>	Double-Click	System
Information===	---	===	---	===	---	===	---	===HP	Device	Home	Page	-	References	and	ResourcesLearn	about	your	Device	-	Solve	ProblemsWhen	the	website	support	page	opens,	Select	(as	available)	aCategory>Topic>SubtopicNOTE:	Content	depends	on	device	type	and	Operating	SystemCategories:	Alerts,	Warranty	Check,	HP	Software	/	Drivers	/
Firmware	Updates,	How-to	Videos,Bulletins/Notices,	How-to	Documents,	Troubleshooting,	Manuals	>	User	Guide,	Service	and	MaintenanceGuide	(Replacement	Parts	and	Procedures),	Product	Information	(Specifications),	moreOpenHP	15.6	inch	Laptop	PC	15-e2000	(2J4W0AV)Thank	you	for	participating	in	the	HP	Community	--	People	who	own,	use,
and	support	HP	devices.Click	Yes	to	say	Thank	YouQuestion	/	Concern	Answered,	Click	my	Post	"Accept	as	Solution"	Dragon-Fur	View	solution	in	original	post	If	you	do	not	have	your	original	disk	or	are	looking	for	updated	drivers,	your	best	option	is	to	download	the	current	drivers	from	the	HP	support	site.	The	address	is	support.hp.com	and
following	the	steps	below	will	allow	you	to	find	the	drivers	you	need.1.	When	you	get	to	the	website	click	on	the	"drivers	and	software	"	icon2.	On	this	screen,	you	will	have	2	options.	If	you	have	registered	your	product	and	have	an	account	it	will	show	these	devices	and	you	can	click	directly	on	them,	like	the	PC	showing	here.	If	not,	click	on	printer	as
in	the	picture.3.	Type	in	the	model	of	your	printer	such	as	2600.	If	there	is	more	than	one	product	that	matches	your	search	a	dropdown	menu	will	appear	and	you	simply	click	on	the	device	that	matches	yours.	Or	you	can	browse	the	list	of	popular	products	at	the	bottom	of	the	page	to	see	if	yours	is	listed.4.	The	next	page	will	show	a	list	of	drivers
and	optional	software,	including	current	firmware	that	is	available	for	your	product.	The	drivers	can	be	in	a	couple	of	places	as	circled	below.	If	your	product	is	supported	by	the	HP	Universal	Print	driver,	that	will	be	an	additional	option,	but	the	sample	printer	I	chose	does	not	support	it.	Most	often	the	first	option	will	either	be	a	link	for	HP	Smart	(if
supported).	The	software-utility	category	is	usually	a	full	installation	package	designed	for	printing	and	scanning	in	stand-alone	mode	(no	internet	required	for	scanning)Below	is	an	example	of	a	product	that	does	support	UPD	and	as	you	can	see	there	are	more	options	for	installation.	The	site	will	normally	show	all	available	options	that	your	device
can	utilize.When	you	select	on	of	the	options,	it	will	either	provide	basic	install	instructions	or	there	will	be	a	downloadable	readme	file	that	provides	installation	instructions.	Down	load	the	install	that	you	wish	to	use	and	follow	the	instructions	provided.	Instructions	will	vary	depending	on	installation	method.	Hi,First,	restore	the	network	settings	of
the	printer	as	following	in	order	to	reconfigure	its	connection:Download	the	latest	Windows	11	software	below	to	reinstall	the	printer	software,	during	the	installation	select	a	Wireless	connected	and	follow	the	steps	to	configure	the	wireless	connection	for	the	printerNote	that	you	will	be	required	to	temporary	connect	a	USB	cable	during	the	process
to	reconfigure	the	printer	for	a	wireless	connection.Shlomi	Click	the	Yes	button	to	reply	that	the	response	was	helpful	or	to	say	thanks.If	my	post	resolve	your	problem	please	mark	it	as	an	Accepted	Solution	Hi	@ltcfaucetbox	Welcome	to	the	HP	support	community.I	understand	you're	experiencing	an	issue	with	your	HP	device,	and	I	apologize	for	any
inconvenience	this	may	have	caused.	I'm	here	to	help	you	today.Possible	Solutions	for	Installing	HP	Drivers	After	Windows	11	Installation:1.	Perform	a	Clean	Installation	of	Windows	11	Without	Network	ConnectionThis	method	involves	disconnecting	from	the	network	during	the	installation	process.	By	doing	this,	Windows	11	won't	have	access	to	the
internet	and	will	not	attempt	to	install	drivers	from	Microsoft's	online	repository.	Here's	how	to	do	it:	Disconnect	from	the	internet	(either	through	Ethernet	or	Wi-Fi)	before	starting	the	installation	of	Windows	11.	Install	Windows	11	as	usual.	During	the	installation	process,	Windows	will	not	be	able	to	fetch	drivers	from	the	internet,	so	it	will	rely	on
the	built-in	basic	drivers.	After	the	installation	is	complete,	reconnect	to	the	internet.	Now	that	you	have	Windows	11	installed	with	the	basic	drivers,	you	can	download	and	install	the	latest	drivers	from	HP	manually.You	can	do	this	by	visiting	HP's	Support	Website	and	downloading	the	appropriate	drivers	for	your	laptop	model	(HP	Pavilion	15-
eh1000).	Once	downloaded,	you	can	manually	install	them.	Make	sure	to	install	them	in	the	following	order:	Chipset	drivers	Audio	drivers	(which	include	the	B&O	Audio	Control)	Graphics	drivers	(if	needed)	Wi-Fi	/	Bluetooth	drivers	(if	applicable)This	method	should	allow	you	to	bypass	the	issue	where	Windows	11	installs	its	generic	drivers
automatically.2.	Using	HP	Support	AssistantThe	HP	Support	Assistant	can	help	with	driver	installation	after	the	operating	system	is	installed.	Heres	how	to	use	it:	Download	HP	Support	Assistant:	If	you	dont	already	have	it	installed,	you	can	download	HP	Support	Assistant	from	HP's	official	website.	Install	HP	Support	Assistant	after	youve	installed
Windows	11	and	reconnected	to	the	internet.	Run	HP	Support	Assistant	and	check	for	recommended	updates	or	driver	installations.The	HP	Support	Assistant	should	be	able	to	find	and	install	the	specific	drivers	for	your	system,	including	the	B&O	Audio	drivers	and	others	that	might	be	missing	or	incompatible	after	the	Windows	installation.3.	Install
Drivers	via	USB	(Offline	Installation)If	you'd	rather	avoid	connecting	to	the	internet	during	installation	and	you	need	to	install	drivers	manually,	you	can	also	download	the	necessary	drivers	on	another	computer	and	transfer	them	via	USB.	Heres	the	process:	On	another	computer	with	internet	access,	go	to	HP	Support	and	enter	your	laptop's	model
number	(HP	Pavilion	15-eh1000).	Download	the	drivers	you	need,	including	audio,	chipset,	graphics,	and	any	other	missing	drivers.	Transfer	the	drivers	to	a	USB	flash	drive.	Plug	the	USB	flash	drive	into	your	HP	Pavilion	and	manually	install	the	drivers.This	method	ensures	that	you	have	all	the	correct	drivers	installed	on	your	system	without
Windows	11	interfering	by	downloading	its	own	drivers.4.	Use	Device	Manager	to	Force	Driver	InstallationIf	Windows	installs	incorrect	or	generic	drivers	for	devices	like	the	audio	driver,	you	can	manually	replace	them	using	Device	Manager:	Open	Device	Manager	by	pressing	Windows	+	X	and	selecting	Device	Manager.	Expand	the	"Sound,	video
and	game	controllers"	section.	Right-click	on	the	audio	device	and	select	Update	driver.	Choose	Browse	my	computer	for	drivers	and	navigate	to	the	location	where	you	have	saved	the	HP	drivers	(either	on	the	computer	or	on	a	USB	drive).	Select	the	appropriate	driver	and	install	it.This	manual	method	helps	you	install	specific	drivers	for	each	device
without	relying	on	the	generic	drivers	Windows	installs	automatically.5.	Prevent	Windows	from	Installing	Drivers	AutomaticallyIf	you	want	to	make	sure	that	Windows	does	not	download	and	install	drivers	automatically	in	the	future	(either	during	installation	or	after),	you	can	configure	Windows	Update	settings	to	prevent	automatic	driver	updates:
Go	to	Settings	>	Windows	Update	>	Advanced	options.	Scroll	down	to	the	Driver	Updates	section	and	turn	off	Receive	updates	for	other	Microsoft	products	when	you	update	Windows.Alternatively,	you	can	use	the	Group	Policy	Editor	or	Registry	Editor	to	disable	automatic	driver	updates.	This	can	be	more	complex	and	is	typically	recommended	for
advanced	users.	I	hope	this	helps!	Keep	me	posted.Please	click	Accepted	Solution	if	you	feel	my	post	solved	your	issue,	it	will	help	others	find	the	solution.-RegardsRaj-HP	Support	Raj2111	I	am	an	HP	Employee	
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